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The following changes have been made to the DAT/EM SUMMIT EVOLUTION PRODUCT between Release 6.5 and 
Release 6.6. Please review these revisions made to the software and update your software to implement changes. 
 
As always, DAT/EM welcomes comments and suggestions from you, our clients, so please don’t hesitate to contact our 
support department at support@datem.com, or by calling in or faxing us with your requests. 
 

Operating Systems 
Release 6.6 is supported on Windows XP Professional and Windows 7 Ultimate or Professional operating systems. 
Testing no longer occurs for Windows 2000 or VISTA Ultimate. If you have a question, please contact Support. 

CAD Versions 
Release 6.6 has interfaces to the following 32-bit and 64-bit CAD versions: 

 AutoCAD: Autodesk 2004, 2005, 2006, 2007, 2008, 2009, 2010, 2011, 2012, and 2013 products. This is the first version to 
support AutoCAD 2013. DAT/EM software will install for multiple AutoCAD products of different year numbers on the same 
computer; however, it will not install for multiple same-year versions together. For example, it will not install for both 2012 and 
Map3D 2012.  
BE ADVISED: Version 6.6 no longer supports AutoCAD 2000-2002 versions. If you use these old AutoCAD versions, please 
upgrade to AutoCAD 2004 or higher. AutoCAD version 2007 or higher is needed in order to use the new MAPEDITOR. 
 

 ArcGIS: ArcMap 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2) and 10.0 (service pack 4) 
 

 MicroStation: MicroStation V8 and V8 2004 Edition, XM, V8i Select Series 1 and 2, and Bentley Map Select Series 1 and 2 
are approved. Select Series 2 is recommended over Series 1. 

o Note for Select Series 1-to-2 upgrades: If you upgrade to MicroStation or Bentley Map from Select Series 1 to 
Select Series 2, you must reinstall any DAT/EM software after installing Select Series 2. 

o DO NOT USE SELECT SERIES 3: DAT/EM software does not install for Series 3.. 
 

Hardware Locks/Dongles 
Please install Microsoft Updates and Service Packs for your operating system before applying lock reset programs. 
Network licensing should have the same Sentinel driver version on both the server and the local computers running the 
software. 
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Summit Evolution 
The following changes have been made to Summit Evolution and the applications that are provided with it. 

1. There is a new Groups tab on the Project window for all stereo project types. Groups are subsets of the models 
in a project. They allow you to define groups of models so that the Tools>Options>Project>Automatically load 
next model… function will only open models from the same Group. 

 Groups are especially useful when the project contains multiple image sets from different times/sources, 
and you want a view each set in a different viewport. For example, you have imagery from every two 
years; create Groups for 2008, 2010, and 2012 so that each of three viewports can only open models 
from its assigned Group year. 

 Groups can only be used for stereo imagery in the same Summit project file. That is, all the images are 
from the same major image type (such as all aerial), and all have the same input coordinate systems. 

 Alternative: If your image sets must be in different .smtxml projects or can’t contain model definitions, 
please use multiple Summit instances as described in 0 below. Examples of image sets that can’t use 
Groups include: A combination of aerial and RPC satellite imagery (these require separate projects), any 
image sets that have different input coordinate systems (these require separate projects), and Orthophoto 
Collection projects (these are not stereo, so they can’t define models). 

 
To make groups, start with a Summit project that has 
models defined. Select the Groups tab on the Project 
window. 
 

Select the  button, enter a name for the group, and 
select models to add to the group. Either highlight multiple 

models and press the  button or double click a 
single model to move it to the opposite list.  
 
If all the model names to be selected have a similar string 
in their name, such as “6_4” in this example, enter the 
characters in Regular Expression and press the Select 
button to help highlight the models. 
 
Select OK to finish the group. Repeat to build each group. 
 
A model can belong to more than one group. 
 

Use  to edit and  to delete a highlighted group. 
 

To use Groups, open multiple viewports (View > Viewports). From 
the Groups tab, drag a group name or a model from within the group 
into a viewport. The viewport will show the model and group name in 
the viewport title. When this viewport has focus, it will only 
automatically load the next model if the next model is in its group. 
 
A group may be open in more than one viewport.  
 
As always, non-group models may be opened at any time in any 
viewport by opening the model from the Models or Images tabs. 
Opening a model from the Models or Images tab cancels any group 
that might have been active in the viewport. 
 
 “Group 2” open in a viewport 

“Add a group from the Groups 
tab on the Project Window 
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2. Multiple instances of Summit have changes and may be used as follows: 

a. Any number of Summit instances can now automatically share the 3D input device. (Previously, only two 
instances could share it.) 

b. The Summit instance that has current Windows focus automatically gains control of the 3D input device. 

c. If a non-Summit application has current Windows focus, the Summit instance that most recently had focus 
retains control of the 3D input device. 

d. The SUMMIT that controls the 3D input device can control the cursor in all the other Summit instances, as 
long as the projects have the same output coordinate system. For example, open an aerial project in one 
instance, and open an RPC satellite project of the same geographic area and the same output coordinate 
system in another instance; one instance can control the cursor position in the other instance. The 
instance that has control of the cursor will move the most smoothly. 

e. Alternative: If there is only one .smtxml project file, it is better to use Groups in one Summit instance 
instead of opening the same project in multiple instances (see Groups in item 1 above). 

 

3. Some imported project types, such as DVP and Socet Set SUP, import interior matrices and do not create camera 
files or fiducials. A .smtxml project that does not have a camera file cannot be imported by Trimble Inpho 
products. For this reason, two methods have been added to create virtual camera files and fiducials that result in 
the same orientation as the interior matrices. Please note: 

 The calculated fiducials will not match up visually with the actual fiducial marks on the image (if there are 
any), just as the virtual camera file is not the same as a camera file created with the actual camera 
calibration report. These are calculated fiducials and calculated camera files that produce the same 
orientation as the previously imported interior matrices. 

 DVP digital camera projects will most likely make only one camera file to be used by all the images, but 
other projects will most likely make a different camera file for each image. 

 The virtual camera file name(s) will match the image file name(s) unless only one camera file needs to be 
made. 

 Notes inside the new camera file(s) will say, “Virtual camera file.” 

The two new methods are as follows: 

a) When importing a DVP PAR files project, there is a new choice to create an interior matrix or fiducials 
and virtual camera files. The Interior matrix choice is the original functionality that imports an interior 
matrix, but does not create a camera file. Make fiducials and camera files is the new setting: 
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b) For any existing project that has interior matrices without a camera file, select the new menu option, 
File > Convert interior matrix. Supply the input .smtxml project file and a new output project name. 
A new project with fiducials and one or more virtual camera files will be made.  

 

 

4. SUMMIT>Imagery>Project Histogram is a new option to generate histogram files for each image and apply 
histogram matching to the images in the SUMMIT view. 

 

The first part of the dialog lets you generate histogram files. These are binary files that contain the images 
statistics. The file extension is *.histohfa. These files will be placed in the same folder as the image files. Note 
that they are a binary format, so you cannot view them with a text editor. Next to the Process button is a Zoom 
level selection. For most purposes this should be left at 1X. You can generate them at higher levels, but this 
would mostly be for speed. Images that take 2 minutes to process at 1X might take less than two seconds at 8X. 
Once the histogram file is created, there is no need to process them again unless you want to use a different 
zoom level. For example, if you generate them at 8X and then switch to 2X and hit Process, it will generate new 
histograms; however, if you select 16x it will not generate new files, because the current files are already at a 
higher level. Please note that higher levels are better and there is usually no reason to decrease accuracy. 

Note that 1X-level .histohfa files may also be generated by Image Creator. See item 16.b. on page 12. 
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After generation there will be a button, , for viewing the histograms for each image. For example: 

 

The next half of the dialog deals with Histogram Matching: Off, Match all images to the project histogram, and 
Match stereo pairs. These are project settings. The histogram files are required to use these settings. If the files 
are not there, nothing will happen. With a model open and using the Apply button, the effects for the matching 
can be viewed. Note that if all the images are similar it will be hard to notice the effects. This histogram 
adjustment happens before any other adjustment. The following is an example of this setting: 

Off: Match all images to project histogram: 

Match stereo pairs (this is the average histogram of the two images): 
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5. Contrast Stretch is a new adjustment option on the Imagery>Image Adjustment dialog. Contrast Stretch is a 
linear histogram equalization using the standard deviation locations as the new minimum and maximum. The 
slider bar is the number of standard deviations (StdDevs) from the mean. The range is from 1 to 3 with a default 
of 2 StdDevs. The larger the StdDev, the less effect of the stretch. The histogram is stretched from the number of 
StdDevs to the edges of the histogram. The images that would benefit the most have a histogram distribution 
bunched around the mean. The new distribution would be across the whole histogram. 

 

New Contrast Stretch setting 

 

6. View > Viewports Select 3D SI is a new menu item that allows everyone – including system mouse-only users –  
to toggle the 3D SI-only view in any viewport. The 3D SI-only view was a new option for multiple viewports in 
version 6.5, but could not be set by system-mouse-only users, because it could only be accessed from the right 
click menu in the viewport. The right click menu does not appear if using a system mouse as a SUMMIT digitizer. 
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7. Summit’s Cursor Selection dialog has a new Ground Grid tab to set a grid of lines or points around the cursor 
center. This grid can be clipped to the ground rings (set on the adjacent Ground Rings tab) area or not, and has 
other settings such as angle, color, ground size, and opacity. 

 

The new Ground Grid settings 

   

Examples of different Ground Grid settings results 

 

8. SUMMIT’s File > Export > Export Model Bounds has three 
new Output options: 

 Complete bounds for each model: Draws a polygon 
around each models’ entire stereo area, no matter how 
much it overlaps any other models. 

 Arrange bounds edge to edge per strip only: Draws 
model boundaries that do not overlap the stereo area 
of the adjoining images in the same strip, but may 
overlap stereo model areas from other strips. 

 Full block edge to edge: Draws completely non-
overlapping polygons around stereo areas. In areas of 
multiple-model stereo overlaps, it splits the multiple 
overlap area among the overlapping models. 
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9. Summit’s superimposition  has the following updates: 

a. AutoCAD polyline closing “segments” that have an arc bulge factor now display correctly as arcs in 
superimposition . 

b. Orientation > Show Camera/Kappa Direction is new. It toggles camera direction and kappa angle 
arrows for one or two open images. The setting is off by default and is not a saved setting, so that it is off 
every time Summit starts. The arrows appear at the origin of each open image’s center. For best viewing, 
zoom out so that one or both image centers are in the Main View. 

 

 
Camera direction and kappa angle display for a single open image 

 
Camera direction and kappa angle display for two end-overlapped images from different strips. 

The camera angles are opposite each other, since the airplane was flying different directions for each image. 
The origin for each arrow set is at the image center. Zoom out if this is not currently visible. 
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10. The Camera Editor (Edit > Camera File) has two new Distortion settings: 

Important! The two new camera distortion methods are not backwards compatible with previous versions 
of DAT/EM software. If either of these distortions are present in the camera file, the project must be used 
with DAT/EM software version 6.6 or higher. Older versions will fail if they encounter the new distortions. 
Camera files that do not use either of the new distortions will be backwards compatible. 

a. Distortion > Seven Parameter: This has been added for UAV (Unmanned Aerial Vehicle) projects. 

 

b. Distortion > Radial & [and] Decentering: This is an eight-parameter version that is mostly used when 
importing SUP file distortions. 
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11. Aerial projects have the following orientation and orientation-related changes: 

a. Scanned images from a single frame film camera at different scan scales are now supported. Previously, 
frame aerial images that were scanned at different micron levels did not produce good stereo. Summit’s 
epipolar adjustment now corrects properly for scan scale. 

b. In previous versions, if an UltraCam camera’s project had no EO (exterior orientation) values, 
Tools>Reports placed “Focal Length = 0” in the report file. Now the focal length is reported correctly. 

c. The Tie Points Relative Orientation dialog has two changes: The Overview button has moved to 
prevent accidental activation; the list of models where a point is found has expanded to show more 
models before the gaining a scroll bar. 

 

 

d. Control Transfer for aerial projects has two methods now. Control Transfer changed in version 6.5 to 
allow more project types and to make it work for single images. The new method does not require a 
relative orientation and does not move in relative mode. However, some users missed the aerial project 
method that was available in version 6.4 and lower, because they liked the relative movement mode and 
seeing the points in the Absolute Orientation dialog. Both methods are available now in 6.6. When 
Orientation>Control Transfer is started in an aerial project with relative orientation, a question appears: 

 

 Yes-Method 1 is the method from version 6.4 and lower that shows the points in the Absolute 
Orientation dialog. This method requires a relative orientation and it moves in relative mode. 

 No-Method 2 is the new method that shows the control points in the Tie Points dialog. A relative 
orientation is not required. It moves in pixel mode. 

 This is completely the user’s choice. The method makes no difference to the resulting orientation. 

Overview button moved 

Longer list 
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12. VisionMap A3 projects have the following changes: 

a. When a VisionMap A3 projects was open, the north arrow display pointed to the negative of the actual 
north angle. For example, if north was 15º, it would point to -15º. This was a display issue only and had no 
effect on the A3 project. 

b. If two A3 images that are not from the same model are opened, Summit will perform an automatic kappa 
rotation for each image separately in the view. This makes it possible to view two images that “don’t go 
together” for possible stereo viewing. If the images overlap the same ground area, there may or may not 
be good stereo in some parts of the overlap. Summit cannot epipolarize A3 imagery, which means that 
any scaling and skew differences are not corrected. This new kappa rotation may be of some limited use 
in some projects. It is always best to open two adjoining flight line images for a “real model”. 

 

VisionMap A3 images that “don’t go together” displayed at their kappas for possible stereo viewing 
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13. Orthophoto Collection projects (Summit projects made of orthophoto images, not for orthophoto creation) have the 
following changes: 

a. Coordinate transformation is now available. Note that this makes orthophotos more useful for use with 
multiple SUMMIT instances that need to control each other’s cursor position, since all such projects need to 
have the same output coordinate system (see item 2 on page 3 above). 

b. The Project Edit dialog now allows you to select multiple orthophoto image files to add to the project. 
Previously, only one image could be selected at a time. 

14. Satellite RPC projects can now use Astrium© Pléiades satellite imagery. Order the Pléiades Level 1A stereo or 
tristereo imagery in either TIF or JPEG2000 format. JPEG2000 may be preferable due to Windows 7 large TIF 
problems. Create the project with Summit’s RPC satellite project type. 

Note that Pléiades imagery is offered in either TIF or JPG2000. Use the Image Creator for either format: 

 Pléiades TIF is not tiled and does not contain image pyramids, so it must be processed with DAT/EM 
Image Creator with a recommended setting of New TIF and PYR. “New TIF” tiles the 1X image and 
“PYR” makes the zoom level pyramids. Microsoft Windows 7 has known problems dealing with large TIF 
files; be sure your original TIFs are not located in the same folder as the “New TIF” destination. Use a 
different destination folder in Image Creator. If the folder is the same, Windows will fail to rename the new 
file “_new” to differentiate it from the old file, and the original file may disappear. Windows 7 can also lock 
up when copying or moving Pleiades TIF files; this is not DAT/EM’s problem, but rather Microsoft’s. 

 Pléiades JPG2000 may be opened as-is, but be aware that JPG2000 is slower to load and tile than TIF. 
DAT/EM strongly recommends processing JPG2000 with the Image Creator set to New TIF and PYR. 

Note that once a Pléiades RPC project is made, it must be used with DAT/EM version 6.6 or higher; it is not 
backwards compatible due to Pléiades’ new RPC file format and new JPG2000 format. 

 

15. Contour Creator has no changes. Please note that Contour Creator can trigger a MicroStation crash when writing 
contours directly into MicroStation V8i Select Series 2. This problem is in DAT/EM Capture for MicroStation, not 
Contour Creator. The problem was identified too late to be completely fixed for version 6.6. If you experience this 
problem, please contact DAT/EM Support and ask to be notified when an update is available. 

  

16. Image Creator has the following changes: 

a. It can now process the new JPEG2000 image format changes as seen in Astrium Pléiades satellite 
imagery. This file format compatibility applies to Image Creator, Summit Evolution, and any other DAT/EM 
product that reads images. 

b. Generate histogram file is a new setting to create 1X-level histogram .histohfa files. These may be 
used in Summit’s new Imagery>Project Histogram tool shown above in item 4 on page 4. 

 

Image Creator’s new Generate Histogram File setting 
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17. Project Viewer / Ortho+Mosaic has the following changes: 

a. Both the straight seam line and optimized seam line generators have been rewritten. They now create 
joined seams, no matter how many image overlaps and kappa angles are present. 

The Generate Seams dialog is simplified to only ask to generate or remove seams: 

 

  

                                                                          New version of dialog for straight line seams 

 

 

This example shows the seams generated for 109 greatly overlapping images with many different flight line angles 
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Project Viewer / Ortho+Mosaic changes, Continued. 

 

 
This example shows the seams generated for a set of traditional left-right/right-left flight lines. 

It is no longer necessary to edit separate seam lines to meet at the higher-overlap-level corners; 
this is done automatically. Edit manually only if you would like the seams to follow a different path. 

 

The Optimized Seam Line generator additionally processes the seams to find the best path through areas of 
most similarity. For example, forests, water, and buildings tend to be dissimilar between orthophotos, so the 
paths tend to avoid these. Roads tend to be similar, so the paths tend to follow them.  

The Optimal Seam Line dialog has a slider with three states. The leftmost setting will generate the fastest, but 
will have result in less defined paths. The rightmost setting will generate the slowest, but will result in better 
defined paths. The middle setting is often the best choice and is always the default. The generator is 
multithreaded and will use up to 5 background threads, depending on the computer. This processes much 
faster than the older version. 

  

                                                                    New version of the dialog for optimized seams 
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Project Viewer / Ortho+Mosaic changes, Continued. 

The only points that are not optimized or moved are the join locations where multiple seam lines meet. The 
join point may not be on an optimal path, but it is the best join location in the overlap area. If desired, view 
each join and manually edit only if necessary. 

 

Example of optimized seam lines generated at the default (middle slider bar) setting 

b. Defined mosaic boundaries that are not positioned over any input orthophoto will be written out as 100% 
background pixel color. Previously, the image would not be created if it didn’t have any image pixel colors 
in it. Now DAT/EM assumes that if the user creates a mosaic boundary, then the image should always be 
created. It is up to the user to use or discard all-backgroud-color images if they are not wanted. 

c. Boundary Grid is a new interactive method to create a grid of named mosaic boundaries: 

 Select the Grid Boundaries icon on the Mosaic toolbar and make settings:   
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Project Viewer / Ortho+Mosaic changes, Continued. 

 

 Either key in exact coordinates or move the grid interactively on screen using the  button. 

 Use the  button to label each grid location. Mosaic files will be named according to these labels. 

 Use the  button to export the grid boundaries to a CAD/GIS file. 

 The new boundary grid will not have a 1-pixel overlap. It is made to use with the overlapped boundary 
processing method, which will always be used automatically. 

 A boundary grid may be combined with any other boundaries, if necessary. 

 If a boundary grid is in use with other boundaries, all boundaries are treated as overlapped regardless 
of the Inclusive/Overlapped setting that is made on the Main tab of the Create Mosaic dialog. 

 If a boundary grid is not active, then any other boundaries may use either Inclusive or Overlapped 
on the Main tab of the Create Mosaic dialog. (Note that these settings were added in version 6.5. Use 
the context-sensitive “?” dialog help for information on these settings.) 

 

d. Mosaic boundary names keyed in to the Mosaic Image Boundaries dialog were not being saved. The 
names would be blank the next time the dialog was viewed, and the names would not be used to name 
the output files. This has been fixed. 

 

“Name” column contents now saved correctly 

 

  


